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Workshop 7B- Protein Isolation and purification

Part I- Fractionation and dialysis

Instructors Chu-Xiong Liao, Joel Nott, 1182 Mol. Biol. Bldg., Phone 294-3267,
protein@iastate.edu, http://www.protein.iastate.edu
Louisa Tabatabai, 4212 Mol. Biol. Bldg., Phone 294-6284, lbt@iastate.edu

Introduction
The first step in protein purification involves a cell disruption step.  The method of choice
depends on the type of cell.  In general, animal cells are easier to disrupt than bacteria, yeast or
plant cells.  The table below summarizes some of the methods.  This list is by no means
complete, as there are as many methods of disruption as there are types of cells.

Cell Type Method Comment

Bacteria
Plant cells

French press Shearing forces disrupt cell wall as the cells
are forced through a small opening under
very high pressure.  Not practical for large
volumes.

Bacteria Sonication Disruption of cell walls by shearing and
cavitation.

Bead Mill Cell wall sheared through abrasion with glass
beads.

Animal Cells Blender Homogenization of tissue or cells will
disrupt cell walls.

Plant Cells
Bacteria
Spores

Blender Glass beads (100-200 µm) are used to
disrupt some bacteria, plant cells and
bacterial and fungal spores.

Bacteria Lysis Solubilization of cell membranes by
treatment with lysozyme and EDTA; Gram-
positive bacteria are more susceptible than
Gram-negative bacteria.

Bacteria
Yeasts

Lysis Solubilization of cell membranes with an
organic solvent such as toluene.

Reference: J.F. Robyt and B.J. White, Biochemical Techniques: Theory and Practice, Brooks/Cole Publishing
Company, Belmont, CA,  1987, Chap. 8.
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Once an appropriate method has been selected, the cells or tissues are suspended in an
appropriate buffer with or without reducing agents, such as β-mercaptoethanol (20-30 mM) or
dithiothreitol (2-5 mM).  After disruption is complete, the suspension is centrifuged at low
speed (4,000-5,000 x g) to separate cell debris from the extracted and solubilized proteins.  If a
membrane preparation is desired, then the supernatant of  the 4,000 x g centrifugation step is
centrifuged at 30,000-100,000 x g, (the speed is dependent on the source of the cells).  Membrane
proteins can be extracted with various ionic or nonionic detergents (Deutscher).

Concentration and partial fractionation of a protein “extract”--The salting-out technique of
protein purification is mainly dependent on the hydrophobic character of the protein.  The salt is
dissolved into the solution containing the protein.  Water will solvate the added salt ions,
decreasing the solvation of the protein itself.  This decrease in solvation exposes the hydrophobic
regions of the protein, which then interact with each other to form aggregates that will
precipitate.  For this laboratory experiment, we will use ammonium sulfate.  The optimum
concentration of ammonium sulfate required to precipitate the protein of interest is determined
by adding increasing amounts of the ammonium sulfate and saving the precipitate for further
analysis.  A table is included in this handout for preparing protein solutions of different
concentrations of ammonium sulfate.  One disadvantage of this method is the high amount of salt
that must be removed from the precipitate.  To remove the salt from the protein sample, we will
use both dialysis and gel filtration chromatography.

Sample: Bovine serum albumin and lysozyme in water
Procedure: Ammonium sulfate precipitation

1.  Pipet 3.0 mL of protein solution into a 50 mL centrifuge tube labeled 0-50 (be sure to put
your name on the tube as well).

2.  Weigh out the required amount of ammonium sulfate for 50% saturation at 0°C (see table).
The initial concentration of ammmonium sulfate is 0%.
NOTE:  The table uses grams/liter.  Calculate the amount of ammonium sulfate needed for
3.0 mL of protein solution.

3.  Add 1/3 of the ammonium sulfate to the 50 mL centrifuge tube, swirl the tube and allow to
dissolve.  Repeat with the remaining portions of ammonium sulfate.

4.  Place the centrifuge tube on ice for 15 minutes.

5.  Balance your tube with another student’s tube.  Centrifuge for 10 minutes at 10,000 x gravity.
Remember the position your tube was placed in the rotor.

6.  Label a 15 mL tube “50-70”.  Decant the supernatant from the 50 mL centrifuge tube into the
15 mL tube marked 50-70.  Measure the volume of the 50-70 supernatant in the 15 mL tube and
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save for step 7.  Dissolve the white precipitate (in centrifuge tube) in 1.0 mL of distilled
water and transfer this to a microcentrifuge tube marked “Dialysis”.

7. Transfer the supernatant from the 15 mL tube labeled 50-70 into the 50 mL centrifuge tube.

8.  Weigh out the required amount of ammonium sulfate for 70% saturation at 0°C (see table).
Remember the initial concentration of ammonium sulfate is 50%.

9.  Add 1/3 of the ammonium sulfate to the 50 mL centrifuge tube, swirl the tube and allow to
dissolve.  Repeat with the remaining portions of ammonium sulfate.

10.  Repeat steps 4 and 5.

11.  Decant the supernatant from the 50 mL centrifuge tube.  Discard the supernatant into the
waste container.  Save the white precipitate for desalting on a column (done in the next lab
period).
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Final Concentration of Ammonium Sulfate:  Percentage Saturation at 0°

Percentage saturation at 0°

Initial concentration 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 100

of ammonium sulfate Solid ammonium sulfate (grams) to be added to 1 liter of solution

0 106 134 164 194 226 258 291 326 361 398 436 476 516 559 603 650 697
5 79 108 137 166 197 229 262 296 331 368 405 444 484 526 570 615 662
10 53 81 109 139 169 200 233 266 301 337 374 412 452 493 536 581 627
15 26 54 82 111 141 172 204 237 271 306 343 381 420 460 503 547 592
20 0 27 55 83 113 143 175 207 241 276 312 349 387 427 469 512 557

25 0 27 56 84 115 146 179 211 245 280 317 355 395 436 478 522
30 0 28 56 86 117 148 181 214 249 285 323 362 402 445 488
35 0 28 57 87 118 151 184 218 254 291 329 369 410 453
40 0 29 58 89 120 153 187 222 258 296 335 376 418
45 0 29 59 90 123 156 190 226 263 302 342 383

50 0 30 60 92 125 159 194 230 268 308 348
55 0 30 61 93 127 161 197 235 273 313
60 0 31 62 95 129 164 201 239 279
65 0 31 63 97 132 168 205 244
70 0 32 65 99 134 171 209

75 0 32 66 101 137 174
80 0 33 67 103 139
85 0 34 68 105
90 0 34 70
95 0 35
100 0

Adapted from “Data for Biochemical Research” (R.M.C. Dawson, D.C. Elliott, and K.M. Jones, eds.), 2nd Ed. Oxford Univ. Press,
London, 1969.
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Dialysis--Dialysis is a procedure to separate smaller molecules (e.g., salt) from larger molecules
(e.g., protein) by using a semipermeable membrane that allows the passage of the smaller
molecules but not the larger molecules.  In this lab we will use dialysis tubing that does not allow
the passage of molecules exceeding 12,000 to 14,000 dalton in molecular weight.  After 4-6 hours
of dialysis, equilibrium is achieved, at which point the concentration of the dialyzable material
(salt) is the same on the inside and outside of the dialysis bag.  If the volume outside the bag is
much larger than the volume inside the bag, there will be a substantial decrease in the salt
concentration within the dialysis bag.  If the outside solution is changed several times during the
dialysis (normally morning, noon and night), an even greater decrease in the salt concentration can
be achieved.

Procedure: Dialysis of the 0-50 ammonium sulfate precipitate

1.  Soak a 20 cm x 1 cm piece of hydrated dialysis tubing in distilled water for five minutes.  Tie a
single knot at one end.  Transfer the protein solution from the microcentrifuge tube marked
“Dialysis” into the dialysis tubing with a plastic transfer pipette.  Be sure to keep the tubing
with the knotted end down.

2.  Remove air above the solution in the tubing by running the tubing between your thumb and
index finger.

3.  Tie a second knot in the dialysis tubing above the solution allowing some head space (but no
air) for the influx of water into the tube during the dialysis.  Place the tube in a 1 L beaker
containing the appropriate buffer (in this case water) and a stirring bar.  Place the beaker on a
magnetic stirring plate.  Stir the solution at a high enough speed to ensure proper circulation of
the water.  Dialyze at 5°C.

4.  Change the dialysis fluid morning, noon and night until the dialysis fluid tests negative for
sulfate with a drop of barium chloride.  The barium cation reacts with the sulfate anion to form an
insoluble white precipitate.  If a precipitate is formed, the dialysis fluid needs to be changed.  Use
1.0 mL of dialysis fluid and 1 drop of saturated barium chloride.
NOTE:  The dialysed sample will be used for HPLC in the next lab period.
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Workshop 7B- Protein Isolation and purification

Part II- Liquid Chromatography

Instructors:  Chu-Xiong Liao, Joel Nott 1182 Mol. Biol. Bldg., Phone 294-3267,
protein@iastate.edu, http://www.protein.iastate.edu
Louisa Tabatabai, 4212 Mol. Biol. Bldg., Phone 294-6284, lbt@iastate.edu

Introduction--High-performance-liquid chromatography (HPLC) is at present the most common
technique used to purify and characterize peptides and proteins.  Used in conjunction with gel
electrophoresis, it offers to the protein chemist an extremely powerful tool that has enabled the
design of purification protocols unrealized before its advent.  It is now possible to purify and
characterize minute amounts of protein and peptides from a vast array of starting material from
contaminating material.  The general proliferation of HPLC-based techniques can be directly
related to such attributes as sensitivity, speed, cost, and convenience.

Chromatography is a method of separating chemical mixtures into individual components.  It is a
separation technique, not an identification technique.  In contrast, spectrophotometry can
identify the presence of specific molecules in a sample mixture, but its ability to provide accurate
quantitative information is limited when the sample mixture is composed of components of
similar chemical structure, as it cannot separate the components.  For this reason, liquid
chromatography is very often coupled with spectrophotometry including ultraviolet and visible
absorption, laser excitation and fluoresence methods.  For example, chromatography provides the
most practical method of identifying and quantifying the individual B vitamins from a multi-
vitamin tablet.  The same situation applies in the analysis of polymers and many other types of
organic compounds.

The components of a liquid chromatography system are shown in the figure below.
Block diagram showing the components of an HPLC instrument

Mobile Phase

Solvent
Delivery
System

Injector

Packed Column

Separated materials
elute from the column

Detectors

Recorder

Waste or collect

Concentration

Time

Injection of sample
mixture containing
materials A, B & C

| |C| |B| |A|

Chart Record

A B C
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With liquid chromatography the sample mixture to be analyzed is dissolved in a suitable solvent
(ideally this solvent is identical to the mobile phase) and introduced, by means of an injection
device, onto the head of the column.  The sample is then carried through the column by a
continuous flow of mobile phase from the pump.

Some components of the sample will travel through the column more slowly than others.  Those
components that are more attracted to the column packing material are thus separated by the time
they emerge, or elute, from the column end.  Typically, an ultraviolet absorbance or refractive
index detector monitors the components as they emerge from the column through a beam of light
located at the end of the column.  The detector transmits signals to a recording device that
typically plots the data on a chart.  This chromatogram may provide both qualitative and
quantitative information about the sample.

Liquid chromatography is an innovation of analytical chemistry for both chemists and biologists.
Below is a list of some of the application areas where liquid chromatography is a vital analytical
technique.

Applications Areas
1. Pharmaceuticals

Research & Quality Control
2. Clinical

Drug monitoring, Disease Markers
3. Forensics
4. Pesticides

Research & Quality Control
Environmental Analysis

5. Biochemical Research
6. Food & Beverage
7. Polymer/Plastics

There are four major modes of liquid chromatographic separation:
• Size exclusion chromatography
• Normal phase chromatography
• Ion-exchange chromatography
• Reversed phase chromatography
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Size Exclusion Chromatography--Size exclusion chromatography (SEC) is a general term that
includes both GPC (Gel Permeation Chromatography) and GFC (Gel Filtration
Chromatography).  GPC is considered organic-based SEC and GFC is aqueous-based SEC.

SEC presents the simplest separation mechanism in chromatography.  Optimally there is no
adsorption involved, and the mobile phase should be considered as a carrier phase, not one which
has a large effect on the chromatography.  Molecules are actually separated on the basis of
molecular size in solution.  This is achieved with a porous packing material which is compatible
with the mobile phase.  The smallest components in the sample migrate into the smallest pores of
the packing while the molecular dimensions of the higher-molecular-weight components prevent
them from penetrating as far into the pores.  Therefore the largest molecules will elute first and
the smallest molecules will elute last.

SEC is more susceptible to flow than any other chromatography.  This is due to
1)  HETP (Height equivalent to a theoretical plate) will increase rapidly with flow.
2)  High flow rates simply push the molecules through the column, not allowing complete
permeation of the pore volumes.
3)  Calibrations and subsequent calculations are based on flow; reproducible, accurate flow is
crucial for accurate results.

Gel Filtration Chromatography

Procedure:  Desalting of the 50-70 ammonium sulfate precipitate using gel filtration
chromatography

1.  Dissolve the second ammonium sulfate precipitation (50-70) in 1.0 mL of distilled water.
NOTE:  The volume of the solution should not be greater than 10% of the column volume.

2.  Wash the column with 1 column volume of water by pouring 10.0 mL of distilled water into the
top of the column and letting the water run through the column until the water level reaches the mark
on the column.  DO NOT let the column run dry.  The level of liquid should be kept above the mark
on the column during this experiment.

3.  Number 15 glass culture tubes from 1 to 15 and mark them with your initials.  Transfer 1.0 mL
of water into a tube and place a mark at the level of the water.  Place a mark at the same level on the
other 14 tubes.

4.  Load 0.5 mL of the 50-70 ammonium sulfate solution onto the column using a transfer pipette.
Allow the solution to drain to the mark on the column while collecting the effluent into tube 1 at the
same time.  Add 1 mL water to the column and collect the effluent.

5.  After the sample has drained to the column mark and you have collected the effluent, add 15.0
mL of distilled water to the column and collect 1.0 mL of effluent into each glass culture tube
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(numbered 2-15) sequentially.  You will know that 1.0 mL is in the tube when the level reaches the
mark you placed on the tube in step 3.

6.  Add 10.0 mL of distilled water to the column to re-equilibrate it.

7.  Read the absorbance of the effluent in each tube (1-15) on the spectrophotometer.

Instructions for use of the spectrophotometer:
Simple Reads Function

a. Click on the Simple Reads icon on the desktop.
b. Select Set-up, change Read at Wavelength to 280, make sure that the Ave Time is set to

1.0000 and the Y-Mode is Abs.  Click Ok.
c. Select Edit->Edit Report and enter your name below the instrument line.
d. Transfer your blank solution to a clean cuvette and place in the instrument.  Click Zero, then

Read.
e. Transfer the first solution from the glass culture tube into an empty cuvette and place in the

instrument.
f. Click Read.
g. Transfer the solution from the cuvette back into the original glass culture tube.
h. Repeat step e. through g.  for each glass tube collected from the column.
i. Print the results (File->Print).
j. Exit the Simple Reads program (File->Exit).  Click Ok when asked to save the data.

8.  Plot the fraction number (X) versus the absorbance (Y).  You should see a rise in the absorbance
indicating where the protein came off the column.
NOTE:  Tubes containing protein are collected and after appropriate buffer change by dialysis are
ready to be loaded on a appropriate column for further purification.

9.  Add 1 drop of barium chloride to each tube and note where a white precipitate is formed.  You
should see white precipitation where the salt came off the column.

Normal Phase Chromatography
1.  Adsorption Chromatography
This is the oldest form of liquid chromatography.  The technique depends upon specific
interactions of the solute with the surface of a finely divided adsorbent.  The adsorbent can be
silica gel (the most popular), alumina, or charcoal (rarely used).  Generally, we understand that
the mobile phase and the solute molecules are in competition for the active sites of the adsorbent.
The adsorbent-solute interaction is the most important parameter governing the separation by
adsorption chromatography.  If the solute has a higher affinity for the mobile phase, the
compound will not be strongly retained.  If the solute has a higher affinity for the stationary
phase, it will be strongly retained.  In other words, the higher the polarity, the stronger the
interaction; thus, the longer the retention time.
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2.  Bonded Normal Phase Chromatography
This is similar to silica, but the silanols are chemically bonded with a polar stationary phase.  The
basic mechanism is based on the partitioning of the solute between the mobile phase and the
stationary phase.  Very similar to extraction techniques.

Ion-Exchange Chromatography--Ion exchange separations are based upon attractive ionic forces
between molecules carrying charged groups of opposite charge to the charge on the stationary
phase.  Separations are made between a polar mobile liquid (usually water) containing salts or
small amount of alcohols, and a stationary phase containing either acidic or basic fixed sites.  The
separation depends upon the ionic nature of the compound (e.g. pKa), the polarizability of the
molecule, the solvation shell of the molecule, and the relative attraction of the compound for the
ion exchange surface.  After the sorption of the charged sample, desorption is brought about by
increasing the salt concentration (ionic strength) in the mobile phase or by changing the pH of the
mobile phase.  Both ionic strength and pH can minimize the charge (electrostatic) attraction
between the sample and the stationary phase, and hence, make the mobile phase stronger.

Ion-exchange chromatography separation results when sample components move through the
column at different speeds.  At low ionic strengths, all components with an electrostatic
attraction for the ion exchanger will be tightly held on top of the column.  When the ionic strength
of the mobile phase is increased by adding a salt, the salt ions compete with the adsorbed sample
ions for the bonded charges on the column.  As a result, some of the sample components will be
partially desorbed and start moving through the column.  If the salt concentration is higher, the
resulting ionic strength causes a larger number of the sample components to be desorbed, and the
speed of the movement down the column increases.  The stronger the charge attraction of the
sample to the column is, the higher the ionic strength needed to bring about desorption.

At a certain level of ionic strength, no sample components are held by the charges bonded to the
column.  In this case, all sample components will elute at the mobile phase volume (V0).
Somewhere in between total adsorption and total desorption one will find the optimal selectivity
for a given pH value of the mobile phase.  Thus to optimize retention in ion-exchange
chromatography, a pH value is chosen that creates sufficient charge differences among the sample
components.  Then, an ionic strength is selected that competes with these charge differences so
that the relative movement of each component through the column results in the desired
selectivity.

Reversed Phase Chromatography--In reversed phase chromatography, the packing is nonpolar
and the solvent is polar with respect to the sample.  Retention is the result of the interaction of
the nonpolar components of the solutes and the nonpolar stationary phase.  Typical stationary
phases are nonpolar hydrocarbons, waxy liquids or bonded hydrocarbons (such as C18, C8, C4,
etc.) and the solvents are polar aqueous-organic mixtures such as methanol-water or acetonitrile-
water.
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The C18, C8, and phenyl bonded phases are most often used in the reverse phase mode.  It has
been estimated that 60-90% of all analytical LC separations are done on bonded phases in the
reversed phase mode.  Bonded phases made by covalently bonding a molecule onto a solid
stationary phase are intended to prepare “liquid coatings” which will be permanent.  Silica is a
reactive substrate to which various functionalities can be attached or bonded.  The functionalities
most widely bonded to silica are the alkyl (C18 and C8), aromatic phenyl, and cyano and amino
groups.

General characteristics of reversed phase chromatography
• Broad scope which allows sample types with a wide range of polarities and molecular

weights to be separated.
• General rapidity of mobile phase column equilibration during methods development and

gradient regeneration.
• General ease of use.
• Applicability to separation of ionic or ionizable compounds by manipulating secondary

chemical equilibrium such as ionization control and ion pairing in the aqueous mobile phase.
♦ Buffering the mobile phase in the pH range from 2 to 5 with one of the common 

buffers, the ionization of the weak acids can be suppressed or controlled allowing 
them to be retained in their neutral form.  Similarly weak bases can be retained in 
their neutral form at pH 7-7.5.

♦ For strong acids and bases ionization control cannot be employed because the 
stability of alkyl bonded phases is diminished below pH 2 and above pH 7.5.  
Highly hydrophilic weak acids and bases often remain difficult to retain with 
ionization control.  In such cases ion pair reversed phase chromatography can be 
used.  In this method, counterions (species of opposite charge to the solutes) 
thereby regulate the retention.  Typically alkyl amines or tetra alkyl amines are 
added to ion pair with acids whereas alkyl sulfates, sulfonates, or phosphates are 
used to ion pair with bases.  The technique is an alternative to ion exchange 
chromatography for analysis of ionic compounds.

• The possibility of special selectivity such as structural or steric are achievable by specific
mobile phase additives:

♦ Metal ions are capable of binding to organic compounds in a very selective 
method which is used for ligand exchange chromatography.  The selectivity 
generated in these metal ion phase systems is based in part on differences of the 
solute (ligand) binding strength to the metal ion.  An alternate approach is the 
addition of various chelating agents (4-dodecyldiethylene-triamine-C12 dien) in 
combination with a metal ion.  The type and strength of the metal chelate 
complex-solute binding can be greatly varied depending upon the chemical 
environment surrounding the metal ion as determined by the chelating agent 
added.
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HPLC instructions

1.  Label a 1.5 mL microcentrifuge tube with your name and the letter “A”.  Cut off the top knot
from your dialysis tubing and pour the dialysed sample solution (0-50 ammonium sulfate
precipitation) into the 1.5 ml microcentrifuge tube labeled “A”.

2.  Label a 0.5 mL microcentrifuge tube with your name and “HPLC”.  Transfer 180 µl of 45%
acetonitrile/water to the 0.5 ml microcentrifuge tube labeled “HPLC”.  Transfer 20 µl of solution
from tube “A” into tube “HPLC”.

3.  To prepare the computer system for your HPLC Run click Control -> S ingle Run….  A new
window will come up.

The HPLC conditions we are using are stored in Method << 542B-LC>>:

Buffer A: 0.1% TFA/water
Buffer B: 0.08% TFA/Acetonitrile
Flow Rate: 1.0 mL/min
Column: Vydac RP C-8, 4.6 mm X 250 mm
Gradient: Keep 40% B in 1.5 min.; 40-100% B in 2.5 min.; 100-40% B in 1 min. and keep 40%

B in 1 min.

4.  If Sample ID: was not highlighted, highlight it by clicking in the field .Type your first name in
the Sample ID: field. Check that the Method: is 542b-c8_lc.met and the Data path: is 542b.

5.  Click the Start button to start the run. A new window will come up.
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6.  Watch the status line until it shows "Waiting For Trigger"

7.  Move the sample injector to the LOAD position.

8.  Inject 200 µL of 40% acetonitrile using the 250 µL microsyringe.  This will wash the sample
loop of the previous sample.

9.  Inject 20 µL of your sample (from the tube labeled as “HPLC”).  Do not remove the
microsyringe from the injection port.

10.  Move the injector arm to the INJECT position.  Your sample will be injected into the HPLC
system.  A beep will be sounded by the computer system.  Remove the microsyringe from the
injection port.

11.  The chromatogram will be shown on the computer screen
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When you hear a second beep or the run time is longer than 5.6 min , click Reports -> Print->
Method Custom Report to printout the HPLC report.

MALDI Instructions
Your dialysed sample will also be analyzed by MALDI-TOF mass analysis.  This is performed by
loading 0.5 µL of your sample onto a sample spot, adding 0.5 µL of matrix (sinapinnic acid, 10
mg/mL) to the sample on the sample spot and mixing thoroughly.  After the sample/matrix mixture
has dried, the sample will be loaded into the Thermo Bioanalysis Dynamo MALDI-TOF mass
analyzer for analysis.
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MALDI Mass Analysis

Matrix Assisted Laser Desorption/Ionization Time-of-Flight (MALDI-TOF) is a mass analysis
technique that was pioneered by Professor Franz Hillenkamp and Dr. Michael Karas of the
University of Münster in Germany.  The Facility has a ThermoBioanalysis Dynamo equipped
with dynamic extraction.  MALDI offers a quick and easy method of mass analysis using a
minimal amount of sample.  The principles involved in the MALDI mass analysis can be seen in
the figure below and are described following the figure.

From Finnigan MAT

Principles of MALDI
• The sample is dispersed in a large excess of matrix material which will strongly absorb the

incident light.
♦ The matrix contains chromophore for the laser light and since the matrix is in a 

large molar excess it will absorb essentially all of the laser radiation
♦ The matrix isolates sample molecules in a chemical environment which enhances 

the probability of ionization without fragmentation
• Short pulses of laser light focused on to the sample spot cause the sample and matrix to

volatilize
• The ions formed are accelerated by a high voltage supply and then allowed to drift down a

flight tube where they separate according to mass
• Arrival at the end of the flight tube is detected and recorded by a high speed recording device
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The time-of-flight of the ion is converted to mass using the following principles:
• An accelerating potential (V) will give an ion of charge z an energy of zV.  This can be

equated to the kinetic energy of motion and the mass (m) and the velocity (v) of the ion
zV = 1/2mv2

• Since velocity is length (L) divided by time (t) then
m/Z = [2Vt2]/L2

• V and L cannot be measured with sufficient accuracy but the equation can be rewritten
m/Z = B(t-A)2

where A and B are calibration constants that can be determined by calibrating to a
known m/Z

Mass of an ion on the Lasermat 2000 is determined by the following method
1.  Measure time-of-flight (t) of the ion
2.  External or internal calibration is used to determine the constants A and B so the time-of-flight
can be converted to mass

m/Z = B(t-A)2

3.  Store B/V so changes in the 20 kV voltage supply does not effect calibration
It is assumed that all ions have the same kinetic energy.

Samples are loaded onto metal plate for analysis on the DYNAMO.  A sample concentration of 1
mg/mL is ideal and usually from one to ten picomoles of sample is required for analysis.  This is
spotted onto the sample position on the metal strip and then 0.5 µL of matrix (usually 10
mg/mL) is applied to the sample position as well.  There are many different matrices that can be
used for MALDI-TOF.  Some of the most common include Sinapinnic Acid (SA) for protein
samples, α-Cyano-4-hydroxycinnamic acid (ACH) for peptide samples, and a 9:1 mixture of 2,5-
Dihydroxybenzoic acid and 2-hydroxy-5-methoxybenzoic acid (sDHB) for carbohydrate and
sometimes protein samples.  DNA can also be analyzed using MALDI-TOF by employing
different matrices.  New matrix solutions are now in development which will yield greater
sensitivity and resolution.

MALDI technology has many applications in the biochemical field.  It can be used to easily
monitor and optimize enzymatic digests, characterize proteins, or can be used for quality control
for peptide synthesis.  MALDI has also been used as a method of N-terminal and C-terminal
protein/peptide sequencing.  There are also applications in the rapid conformation of post
translational modifications and the quantitation of drugs and chelators conjugated to monoclonal
antibodies.
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MALDI Sample Preparation

MALDI samples should be free of SDS, and should not be radioactive.  It is best to remove
buffer salts and detergents (e.g. by dialysis) prior to analysis and to dissolve the sample in a
suitable solvent (e.g. 0.1% TFA/water) which will not degrade the spectrum.  If there is too much
salt in a sample, the salt signal intensity is so large that it effectively suppresses out the sample
signal, giving no sample spectrum.  In cases where it is not possible to remove these
contaminants the sample should be in a higher concentration.  It may then be possible to dilute
the sample to the point where the contaminants will have little effect on the spectrum.
Levels of buffers and detergents which exceed the following limits will probably cause noticeable
degradation of the spectrum:

Phosphate buffer >50mM
Ammonium bicarbonate >30mM
Tris buffer >100mM
Guanidine >1M
Detergents(e.g. Triton-X) >0.1%
SDS >0.01%
Alkali metal salts >1M
Glycerol >1%
Sodium Azide >1mM
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Common matrices used for MALDI

     

CO2H

Benzoic acid
           

CH CHCO2H

Cinnamic Acid

      

CO2H
HO

OH

2,5-Dihydroxybenzoic acid
              (DHB)

CHOHCH3OOCH3CHCO2H3,5-Dimethoxy-4-hydroxy-cinnamic acid               (Sinapinic Acid)

CO2H
HO

CH3O

2-hydroxy-5-methoxybenzoic acid

                (2H5MBA)      

CH C(CN)CO2H

OH

α-Cyano-4-hydroxycinnamic acid

                       (ACH)

       

N C OH

O

Picolinic acid       

N C OH

O

OH

3-Hydroxypicolinic acid

            (3HPA)
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Equipment List--Workshop 7B

A) Fraction & dialysis
Source

1) Protein solution
add 1g of BSA and 1g of lysozyme to 100 ml of water

Sigma

2) 50 ml centrifuge tube Nalge Company
3) 15 ml tube Corning
4) Am2SO4 Fisher Scientific
5) Weighing paper VWR
6) Dialysis tube Spectrum Medical Industries
7) 1 liter Beaker: Fisher Scientific
8) Parafilm American National Can
9) Spatulas Fisher Scientific
10) Centrifuge, 4°C Beckman
11) Ice buckets Fisher Scientific
12) Scissors

B) Gel filtration & UV measurement; HPLC & MALDI
1) Desalting column, equilibrated with H2O Bio-Rad
2) Glass culture tube Fisher Scientific
3) Disposable cuvette Fisher Scientific
4) Buffer B (42% ACN) Fisher Scientific
5) HPLC sample
0.3 mg/ml BSA & Lysozme

Sigma

6) Beakers Fisher Scientific
7) Graph paper
8) Saturated BaCl2 Fisher Scientific

NOTE:  The source given above is not the only source for these supplies.


